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Introduction

With intuitive layout and graphical tools, the Perception Reporter is not only a
better choice for report generation, it's a superior way to work. Tightly integrated
with the Perception software, the WYSIWYG Reporter delivers professional
designed reports and provides a natural work flow within your test environment.
Data and results naturally stream into the report without copying or loading.

The Reporter includes tools for text, headers and footers, drawings, tables,
images and displays. Each with a range of background and border options.

Include data in your report ranging from recorded waveforms, detailed
waveforms to calculated results and system settings.It all updates in a single
click.

Apart from the Report sheet that becomes available in the Reporter option, the
Report to Word feature is also installed.

As where the standard Quick Report always creates a new empty document
and places the objects underneath each other, the Report to Word option
makes it possible to place Perception objects at predefined locations in a
template. By doing this a Word report can be generated test after test with
exactly the same layout.

How to install the Reporter option

The Perception software requires a HASP key. HASP (Hardware Against
Software Piracy) is a hardware-based (hardware key) software copy protection
system that prevents unauthorized use of software applications.

Each HASP key contains a unique ID number used for personalization of the
application according to the features and options purchased. The key is also
used for storing licensing parameters, applications and customer-specific data.
If you have purchased the Reporter option as a separate item, you will receive
a personalized "key file". Use this file to unlock the additional features.

You can find the serial number of your key in Help * About Perception
To update the key information:

1 Choose Help » Update Key...
2 In the Open dialog locate the Key File (*.pKey) and click Open.
3 If everything is OK you will see the following message:



HBM

Perception Reporter

Perception (=)

-
1 2 The software copy protection key is successfully updated.
=y

[ ok ]

Figure 1.1: Software copy protection dialog

4 Click OK.
After the installation you can go to Help » About Perception » More... to see
all installed options.

You will need to restart the program before the changes take effect. The
Reporter option is now available.

Reporter work area
The Reporter work area is laid out as follows.

12692-2.0 en
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Figure 1.2: Reporter work area

A Tools for the creation of design elements and objects.

B Attributes of selected item.

C Alignment allows you to align selected objects with respect to each other.
D

Navigator to quickly change the view of your artwork using a thumbnail
display.

m

Document work area

Bottom toolbar

In addition to the tools provided in the reporter work area, there is also a related
menu in the menu bar when the reporter sheet is active, called “Report”, as well
as an additional toolbar in the top toolbar area.
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1.2

1.2.1

Object manipulation
The Tools palette comprises the tools to build the layout of a report.

»

Tools

3 |
Z |5
e

T
>

e | O

o

You can use these tools to create your layout. You can also use the keyboard
accelerator to access the tool. Each tool has its own type of cursor.

You select a tool to insert and manipulate objects.

Insert an object
There are two ways to insert an object:

e with the tool selected, click in the page area
e with the tool selected, click and drag in the page area

To insert an object with a single click:

1 Select the tool of the object that you want to insert. When you hover with
the mouse over the page area, the cursor shape will change to reflect the
selected tool. Usually the intersection of the two hairlines defines the ‘hot
spot’.

2 Inthe page area position the hot spot in the upper left corner of where you

want the object to come. Click and release the mouse button.

12692-2.0 en
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1.2.2

1.2.3

3 A measurement dialog comes up that allows you to specify the size of the
object.

Display @
Size
Width: m ||-|1|'r| - ‘
Height: 1000 [mm |
[ ok || cancel |

4 Make the required modifications.
5 Click OK to accept. Click Cancel to create a 10x10mm default placeholder.
6 Now the related properties dialog will come up.

To insert an object with dragging:

1 Select the tool of the object that you want to insert. When you hover with
the mouse over the page area, the cursor shape will change to reflect the
selected tool. Usually the intersection of the two hairlines defines the ‘hot
spot’.

2 Inthe page area position the hot spot in the upper left corner of where you
want the object to come. Drag the mouse to define the object area.

3 Now the related properties dialog will come up.

You can make the required modifications in the related properties dialogs as
explained later in this section.

Note that headers and footers have a fixed location.

Select an object
To select an object:

e Select the Pointer / Selector tool and click on the desired object. Now you
can:
e Click and drag the object into another position
e Right-click to access the context sensitive menu of the object
e Double-click the object to call up the related Properties dialog

Select multiple objects
You can select multiple objects, for example to move them or to align them.

11
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To select multiple objects:

e Select the Pointer / Selector tool and do one of the following:

e Click and drag a bounding box around the objects to select. The
bounding box may partially overlap an object to include it.
e Hold down SHIFT and click the desired objects. The object that is last
added to the selection is the ‘reference’ object.
1.24 Move an object

When an object is not locked you can move the object to any position on the

page area.

To move a object:

1 When you hover with the mouse over an object, the mouse cursor changes
to indicate that you can move the object.

2 Click on the object that you want to move.

3 Drag the selection to the new location on the work area. When Snap to grid
is on, the object will snap to fixed positions. When Snap to grid is off, you
can also hold down the SHIFT key while dragging to snap to the grid
temporarily.

4 Release the mouse button to drop the object into position.

1.2.5 Scale an object

Scaling an object enlarges or reduces it horizontally (along the X axis), vertically

(along the Y axis), or both. You can scale objects using the handles on the

bounding box.

To scale an object:

e Selectahandle and scale away from the opposite handle with the bounding
box or,

e make the settings on the Attributes palette.

. ﬂg o
=] =%
o n} %.
Figure 1.3: Object scaling possibilities
12 12692-2.0 en
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1.2.6

1.2.7

HINT/TIP

When you hold down the SHIFT-key while scaling an object, the width and the
height of the object will be the same. This is also true when you place an object.
Use the SHIFT-key on lines to constrain the angle to multiples of 45 degrees.
When you hold down the CTRL-key while scaling an object, the proportions of
the object will be constrained, i.e. the relation between width and height remains
intact.

When you hold down the ALT-key while scaling, the anchor point will be
temporarily set to the center of the object.

For more information on the bounding box refer to "Bounding box appearances”
on page 19.

Stacking objects

The Perception Reporter stacks successively drawn objects on a page,
beginning with the first object drawn. How objects are stacked determines how
they display and print when they overlap.

You can change the stacking order of objects in your work at any time.The Bring
to Front and Send to Back commands let you move an object to the top or the
bottom of the stack of objects on its page.

To move an object to the top or bottom position in the stack:

1 Select the object that you want to move.
2 With a right mouse-click call up the context menu and point to Arrange >
3 Inthe submenu that comes up choose Bring to Front or Send to Back

To move an object by one object in a stack of multiple objects you may need
to repeat the above procedure various times for various objects.

Margins, grid and labels
In the document area you can show and hide visual aids. The following visual
aids are available:

e Printer margins The printer margins show the margins as defined by the
printer settings of your default printer. The printer margins are shown as a
black dotted line.

e User margins The user margins are set individually in the Report Setup
dialog. The margins are shown as a colored line. The line color is specified
in the Report Setup dialog.

e Grid The grid is defined in the Grid Settings dialog. The grid is shown as
colored lines. The line color is specified in the Grid Settings dialog.

e Labels Labels are used to identify objects.

13
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The viewing options can be set by toggle buttons in the lower toolbar.

Figure 1.4: Reporter visual aids
A Show/hide grid
B Show/hide user margins

C Show/hide object labels

12692-2.0 en
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1.31

Object containers

Each object is placed within a container. When you insert an object, you define
the container’'s boundaries. By default, the size of the container and the size of
the object are the same and for most objects are locked to each other.

Since each object is placed within a container, various layout options are set
through the container properties.

Container properties
The properties of containers are:

e Line style, line thickness and line color
e Background color
e Shadow

Depending on the type of object, these properties can be more or less evident.

D.-S-A-=-=-0
T |
A C F

Figure 1.5: Object container properties
Fill color

Line color

Character color

Line width

Line style

Shadow

Mmoo w >
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1.3.2 Examples
Below you will see some examples.
The left-most graphic has:
e Fill color = none
e Line color = black
e Line width = small
The center graphic has:
e Fill color = green
e Line color =red
e Line width = medium
The right-most graphic has:
e Fill color = white
e Line color = none
e Line width = N/A
e Shadow = 1 mm with color set to gray
16 12692-2.0 en
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1.4.1

Object attributes

All objects on the report page have a position, size and a label. The position is
defined by the X and Y coordinates of the anchor point of the object. Size is
defined by a Width and Height value. There is a label for each object in the
report. Object position can be locked. An object can be repeated on multiple
pages. You can constrain the proportions of the object.

. Object Attributes a
A —— D001 v| & =
! " b
X 6028 [mm  we—
B—11 —
Y. 5560 |mm —d
FW 6467 [mm  ve—
C—"y — F
L H: 4857 |mm vo—

Figure 1.6: Object attributes palette

List of available objects on the active (visible) page
Anchor point selector

Constrain proportions

Lock position - Repeat on pages

Anchor point coordinates

Width and height of object

Mmoo w >

Positioning and sizing

You can position and size an object directly on the report page. See "Move an
object" on page 12 and "Scale an object" on page 12 for details. For accurate
positioning and sizing use the object attributes. Each object is marked with a

label, to toggle the view of the label use the %% button in the lower toolbar.
To position an object using attributes:

1 Select the object: point and click on the object on the reporter page, or
select an object from the list.

2 gelect the correct anchor point: click on the anchor point icon D to step
through the corners. The active anchor point is highlighted.

3 Enter the required values for the X- and Y-coordinate.

17
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1.4.2

143

To size an object using attributes:

1 Select the object: point and click on the object on the reporter page, or
select an object from the list.
2 To keep the current aspect ratio click on the constrain proportions icon

®v. The icon changes into a ‘linked’ symbol. Click again to ‘unlink’.
3 Enter the required values for the Width and Height. Note that modifying the
size is relative to the currently active anchor point.

Lock object position
To prevent accidental movement of an object you can lock the position of the
object.

To lock the object position:

1 Select the object: point and click on the object on the reporter page, or
select an object from the list.

2 Click on the Lock Object icon &' to lock the position. The icon will change
into a ‘locked’ icon. Click again to unlock the position.

Repeat an object on multiple pages
1 Select the object: point and click on the object on the reporter page, or
select an object from the list.

2 Click on the Repeat icon 2 to call up the Repeat dialog.

Repeat Display D001 @
Range
From: [ i To: |2 T of2

Lock Object

[ ok ][ cancel

3 In this dialog you can set the page Range in which you want this object to
repeat.

4 Select Lock Object when you want to lock the position of the object as
discussed earlier.

5 Click OK to effectuate the settings.

6 Select the Repeat icon again to remove the repeat settings.

12692-2.0 en
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HINT/TIP

When you insert pages within a range that includes repeating objects, the
objects will be included also on the new pages. This is also true when you add
pages directly after a range that includes repeating objects.

You can remove the repeating object feature only on the page of the first
occurrence of the repeating object.

This feature is not available when there is only one page in your report.

Bounding box appearances

On the report page the bounding box of the object gives visual feedback on the
current status: open handles indicate a single object, grayed handles indicate
a repeating object. The black handle defines the anchor or hot-spot. When the
anchor has a cross, the object is locked.

M I [l n
LT LT LT

A B C

Figure 1.7: Examples of bounding box appearances
A Standard bounding box, anchor in the upper left-hand corner
B Bounding box with label, anchor in the upper right-hand corner, locked

C Repeating object, anchor in the lower right-hand corner

19
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1.5 Object alignment
You use the Object Alignment palette to align selected objects along the axis
you specify.
. Object Alignment ~
DEE]
|0 |
The following alignment methods are available:
b _
Left align
" &
Center align
° |:||
Right align
. ==
O
Top align
[ Dl |
Middle align
[ ]
Bottom align
To align objects:
1 Select the objects that you want to align. Refer to "Select multiple objects"
on page 11 for more information on how to select multiple objects.
2 Select the type of alignment.
20 12692-2.0 en
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1.6 Page navigation
You use the Navigate palette to quickly change the view of your work using a
thumbnail display. The colored box in the Navigate palette corresponds to the
currently viewable area in the document window.
- Mavigate &
ROD1
Doz I A
Il
ADD1 ]
A Zoom area
The navigate area displays the objects with their label for reference.
1.6.1 Zoom select
Use the zoom select control on the lower toolbar to use a predefined zoom
factor, or use the zoom tool from the Tools palette to freely set a zoom area in
the page area.
12692-2.0 en 21
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10%
25%
50%
75%
100%
150%
200%
300%
400%
Page width =
= |Full page 'l ® f) I
A B Cc D
Figure 1.8: Reporter zoom tools
A Decrease zoom factor
B Select zoom factor
C Increase zoom factor
D Zoom tool from Tools palette: free style zooming. Click and drag to select
the zoom area.
A  Decrease zoom level
Click on the Decrease button to zoom out. Each click reduces the view
to the previous set percentage. When the page has reached its maximum
reduction level, the button is dimmed.
B Select zoom level
Click the Zoom Level pop-up menu, and choose a zoom level
C Increase zoom level
Click on the Increase button to zoom in. Each click magnifies the view to
the next set percentage. When the page has reached its maximum
magnification level, the button is dimmed.
D Using the zoom tool
To magnify by dragging:
1 Select the Zoom tool
2 Drag over the part of the page you want to magnify.
22 12692-2.0 en
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1.6.2

1.6.3

Moving the zoom area

When the zoom level exceeds a full page, the zoom area indicator is shown in
the Navigate area. You can click and drag this area to a new location. When
you release the mouse, the report page will be updated.

You can also use the Pan tool ‘& from the Tools palette to scroll the zoom area
to a different location

Page select
Use the page select control on the lower toolbar to step through the various
pages when available.

%)

L/J} Page 2 A )

A B

(@)

Figure 1.9: Reporter page tools
A Go to previous page
B Direct page select

C Go to next page

To add pages:

1 Inthe menu select Report > Insert Pages...
2 In the dialog that comes up:

Insert Pages @
Pages: 1 5

Insert: | Before page v|1 z

[ ok ][ cancel

e Select the number of pages that you want to insert
e Select Before or After the selected page
e Select a page as insertion point

3 Click OK when done.

23
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Or, with the Select tool active, right-click in the page area. In the context menu
that comes up select either Insert Page Before or Insert Page After.

To delete a page:

e In the menu select Report > Delete Page.
e or, with the Select tool active, right-click in the page area. In the context
menu that comes up select Delete Page

12692-2.0 en
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1.7

1.71

Report menu

The Report menu lists commands related to Report handling. For layout and
content management use the tools that are provided on the left-hand side of
the document area.

The Report menu is only available when the Report sheet is on top, that is,
visible.

Report k

Report Setup...
Grid Settings...

Insert Pages...
Delete Page

& Load Report...
55] Save Report As...

1 Save Report as Image...

3
2] Refresh Report
&

=% Print Report...
E_j Post Report to Word

Move Sheet 'Report' to  »

Report Setup

The Report Setup menu command opens the Report Setup dialog. This dialog

is used to define the global document properties.

To access the Report Setup dialog:

1 Click Report in the menu bar
2 On the Report menu click Report Setup...

25
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Report Setup @

A ———e Document

Number of pages: 2 Units: mm -

Ak ([4)e

Start page count at: 1

B ———e Pages User Margins —C

Size: | A4 Top: 1000 (mm -

Width: 21000 |mm ~ Bottom: 1000 (mm
Height: 29700 |mm ~ Left: 1000 (mm =

Right: 1000 |{mm =
Orientation: = Coor ]~

[

[ ok || cancel || Apply |

Figure 1.10: Report Setup dialog
A Document setup
B Page setup

C User margins

In the Report Setup dialog you set the global properties of the document:
number and size of pages, orientation and user margins.

To set up your document:

1 Make the global document settings:

e Number of pages Set the initial number of pages for the document.
You may add or delete pages afterwards as required.

e Start page count at By default the page count starts at 1. However,
when you want to add your document after another document, you can
modify the page count here. The page count is available as a variable
in the header and footer objects.

e Units Set the default measurement unit.

2 Set page size and orientation:

e Size Select one of the predefined sizes or set a custom size. When you
modify Width or Height, the size will be automatically set to Custom.

e Orientation Select between Portrait or Landscape

26 12692-2.0 en
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3 Setthe User Margins:
As opposed to the printer margins, you can set your own user margins as
a visual aid to make sure that your document prints fine also on other
printers. Here you set the margins as well as the color of the lines to display
the margins. You can toggle the visibility through the Show Margins button

in the toolbar on the bottom E;,. .
4 Click OK or Apply to finish.

12692-2.0 en 27
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1.7.2

Grid Settings
You can add grid lines to the document area. These grid lines are used as a
visual aid, but also can be used to snap objects.

To access the Grid Settings dialog:

1 Click Report in the menu bar
2 On the Report menu click Grid Settings...

Grid Settings (23]
A ——— Giid Snap —B
| Show grid V| Snap to grd
Color: | Snap per gridline: |1 =
Style: |Ljnes v|
Grdline every: 1000 |mm |
[0k ][ Camcel |[ ey |

Figure 1.11: Grid Settings dialog
A Grid settings
B Snap settings

To set your grid:

1 Make your grid settings:
e Select Show grid to modify the settings. The actual visibility can also
be toggled through the Show Grid button in the toolbar on the bottom

of the Reporter i

In the Color list select a color for the grid.

Choose the Style. This can be either lines or dots.

Set the grid line spacing using the Gridline every setting.

Select Snap to grid if you want objects to snap to the grid. Here you
can also set a higher resolution for the snap. For example for the
visibility you may want to set the grid line spacing to 10 mm. If you set
2 as value for Snap per gridline, an invisible snap grid will be set with
a 5 mm spacing.

2 Click OK or Apply button to effectuate your selections.

12692-2.0 en
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1.7.3

1.7.4

Insert / Delete Pages
You can insert pages at any time on any location.

To insert pages:

1 Inthe menu select Report > Insert Pages...
2 In the dialog that comes up:

Insert Pages @

Pages: 1 5

Insert: ‘Before page v| 1 =

[ ok |[ Cancel

e Select the number of Pages that you want to insert
e Select Insert Before or After the selected page
e Select a page as insertion point

3 Click OK when done.

Or, with the Select tool active, right-click in the page area. In the context menu
that comes up select either Insert Page Before or Insert Page After.

To delete a page:

e In the menu select Report > Delete Page.
e or, with the Select tool active, right-click in the page area. In the context
menu that comes up select Delete Page

Load Report
You can load previously saved reports. This will load the layout of the report,
including all images and references to the data sources.

To load a Report:

1 Do one of the following:
e In the menu select Report » Load Report....

® When available in the toolbar click the Load Report... button “Z

29
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2 Inthe Load Report dialog that comes up select a report file. This can be:
e report file, previously saved through the Save Report As... option as a

*.pReportLayout file
e report layout, included in a virtual workbench file *.pVWB
e report layout, included in a recording file *.pNRF
3 Click on the Open button

12692-2.0 en
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1.7.5

Note

1.7.6

1.7.7

Save a Report
You can save your report for backup purposes. You can save your report as:

e external stand-alone report file: a *.pReportLayout file
e part of a virtual workbench file
e part of a recording file

When you save a report as part of a virtual workbench or recording file, the
‘old’ report information within that file is overwritten. All other data remains
intact.

To save your report file:

1 Do one of the following:
e In the menu select Report » Save Report As....

® When available in the toolbar click the Save Report As... button |
2 Inthe Save Report As dialog that comes up select one of the options

mentioned above in the Save as type list box and enter a name for the file.
3 Click Save.

Save a Report as image

In addition to the standard save capabilities you also have the option to save a
report as an image file. Now a representation of the data is included and fixed.
Choose between the ‘standard’ *.emf format for inclusion in many popular third
party applications, or the specific *.pReportData format.

To save a report as an image:

1 Select Report » Save Report as Image... in the Perception menu.
In the Save Report dialog that comes up select one of the options
mentioned above in the Save as type list box and enter a name for the file.
3 Click Save.

Refresh Report
A report is not updated on-the-fly, or automatically. When you insert a variable
or display, the current value and waveforms are shown.

To update/refresh a report:

e Select Report » Refresh Report in the Perception menu, or
® Click the Refresh button ] in the upper toolbar when visible.
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1.7.8

1.7.9

1.7.10

e Also when you switch to another sheet and return to the Report sheet, the
report is updated.

Print a Report
You can print a copy of your report using the standard print procedure.

To print a report:

1 Do one of the following:
e In the menu select Report > Print Report....

® When available in the toolbar click the Print Report... button =
2 In the Print dialog that comes up make your selections.
3 Click OK.

Post a Report to Microsoft Word

You can post a report directly into Word. Word needs to be active before you
can use this command. When you select this command a new document will
be created in Word. Each page of the report will create a page in the Word
document. The data is placed as a metafile.

To post a report to Word:

e Select Report » Post Report to Word in the Perception menu, or
® Click the Post Report to Word button Ly in the upper toolbar when available.

Move the Report sheet to another workbook
When you have the multiple workbook option installed, you can move the
Report sheet to another workbook.

To move a Report sheet

1 Select Report in the Perception menu.
2 Point to Move Sheet ‘Report’ to and select one of the available options:
e New Workbook to create a new workbook and insert the Report sheet
there, or
e one of the already created workbooks and insert the Report sheet
there.
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1.8

1.8.1

Design tools
The Tools palette comprises the tools to build the layout of a report.

»

Tools

3 |
Z |5
e

T
>

e | O

o

You can use the following tools to create your layout. You can also use the
keyboard accelerator noted between parentheses in the following list to gain
access to the tool. Each tool has its own type of cursor.

R Pointer / selector (S)
i Insert a display (D)
Insert a report table, user table or cursor table (T)
A |nsert text (A)
/ Draw a line (L)
) Insert a rectangle (R)
B Place a header (H)
o Insert an ellipse (E)

24| Insert an image (1)

-2 Place a footer (F)

'@" Scroll / pan zoomed area

2‘) Zoom

Pointer / selector

Before you can modify an object, you need to isolate it from the objects around
it. You do so by selecting the object. A selected object displays a bounding box
which lets you move or scale the object. See "Bounding box appearances” on
page 19. Once you have selected an object you can edit it.
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Note

1.8.2

You can t scale or move objects that have been locked. (See "Lock object
position" on page 18) However, you still have access to the object properties.

The selection tool lets you select objects and group of objects by clicking any
spot on them or by dragging over them. For more information refer to "Select
an object" on page 11, "Select multiple objects" on page 11, "Move an object"
on page 12 and "Scale an object" on page 12.

Insert a display

You insert a display as described in "Insert an object" on page 10. You gain
access to the properties of the display object using one of the following options:

e Directly after placement of the display object the properties dialog comes

up.

With the mouse cursor above the display object, double-click on the object.
Right-click the object. In the context menu that comes up select

Properties...

E

Properties of Display D002

—e Displays: l Source

Do [ reere—

@ Total
"~ Zoom

) Altemate zoom

—e Color

") Black on white
@ Color on white

) Asis (WYSIWYG)

Annatation font...

Show

Vertical cursors
[] Horizontal cursors
[ Slope cursors
Grid lines

Display markers
Header area
Size

H-annotation height:
Y-annotation width:

Trace width:

5.00 @
20.00 @
0.10 E}

==l

—c

0K | [ Cancel

| [ Aoply

J

B

Figure 1.12: Reporter display object properties

A List of available displays within Perception

Output color preferences

B
C Annotation Size
D

Show options for cursor, grid, markers and header visibility
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E

A

Source select: page within display and view select: total, zoomed or
alternate zoom view

List of available displays within Perception
Name(s) of the inserted display(s)

Color preferences
Depending on your type of printer and/or your preferences, you can select
the type of color output for this display object:

Black on white: all text and graphical information will print in black
Color on white: all text and graphical information will print in colors as
used in the original display

e As-is (WYSIWYG): the display will print exactly as defined, including
background color.

HINT/TIP

Although the color preferences are specified as ... “on white”
(background), the background is actually transparent. Using the object
container background color you can set any background color you like,
irrespective of the original background color in the display. See "Container
properties" on page 15 for more details.

Annotation Size

Use this section to size the area that you want to reserve for the
annotation. This size is not related to the size that you set for actual display
itself.

This setting allows you to define an exact waveform area on your report:
waveform area width = display width - annotation width.

You can use this also for the height.
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1.8.3

D Show options for cursor, grid, markers and header visibility
The Show section comprises the various visual aids of the display:
cursors and grid. Only when an option is visible on the display it will be
shown also on the report: if it is not visible on the display it will not show
on the report, without regard to the setting in this dialog.

In addition you can select to show or hide the header area. The header
area provides information about recording name, cursor values and other
information typically located on the event bar of the display.

Markers are labels placed on the display to denote points or ranges of
interest. You can select to show or hide these labels.

E Source select
Here you select the source of the display you want to show. The Page list
allows you to select a page within the selected display.

The option list allows you to select which part of the display that you would
like to use.

Insert a table

Tables are popular objects within a report. A table within the Perception
Reporter consists of rows and columns of cells. A cell is like a text frame in
which you can add text and data sources. A table can have a header.

In addition the table can be set to be a copy of a cursor table. Now number of
rows and columns as well as the contents is fixed. All other table properties can
be set as usual.

You insert a table as described in "Object manipulation" on page 10. You gain
access to the properties of the table object using one of the following options:

Directly after placement of the table object the properties dialog comes up.
With the mouse cursor above the table object, double-click on the object.
Right-click the object. In the context menu that comes up select
Properties...
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A B C D E
Ploperties of Ta|le TOO1 @
Table content
@ Free edit ) Link to Cursor table| ) Link to Usertable
R ¥ | i 1.
HMEESFE®E B UTT |EEE
Example of a Report Table -—l— F
name A {System. Constants. Pi #####E#1}
J name B {System. Constants.e #####}
today is {System.LongDate}
Acquisition Status {System.Status.Acquisition. Test}
Atotal of {System.Status.Trigger.Count} | triggers
| 3 % 80 %
[[(Less «] [ celFort. [ ok ][ cancel |[ Ay |
H ———¢ Table setup
Rows: 5 Columns: 3 Grdlines —G
Cell padding: 100 [mm ] HEmE C°'?" I -
Header Fort... et Weight 0.20 @
Figure 1.13: Reporter table object properties - report table
A Select Table content: Free edit, Link to Cursor table or Link to User table
B Insert/ delete rows and columns
C Set text attributes
D Setalignment
E Insert/format variables
F Table header
G Grid line settings
H Global table setup
I Position of column separators
J  Matrix of columns and rows: cells
Note For linked tables not all options are available.

The following image is an example of a table with the contents and settings as
shown in Figure 1.13 on page 37.
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Example of a Report Table
name A 3.142E+00
name B 2.718
today is vrijdag 24 maart
time 10:05:15
Acquisition status | Run
A total of 12 |triggers

A Table type
You can choose between three types of tables:

Free edit This is the standard, free configurable table.

Link to Cursor table This is a predefined table. Setup and values are
copied from a cursor table. You can select to which display and
display page you want to connect. Also you have the option to select
the format and cursors. Minor modifications to the layout are allowed.
For details refer to "Cursor table additional settings" on page 43.
Link to User table The User Table is a user configurable table that
can be used to show any non-waveform data source like
(intermediate) scalar results, text and system constants and variables
in a tabular form. For more information about User tables refer to the
Perception manual chapter, “User tables”.

B, J Rows, columns and cells
A table typically has a body with rows and columns and a header that
spans the entire table. Each intersection of a row and a column is a table
cell and each cell can contain text, variables or both.

To expand or contract the table matrix

In the Table Properties dialog make sure you see the More options.
In the Table setup section enter the number of columns and rows you
want.

To add a single row or column

Select a cell adjacent to where you want a new row or column to
appear. In the toolbar, click the Add Row before button m, the Add
Row after button m, the Add Column before button E, or the Add
Column after button .
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To delete a single row or column

e Select a cell within the row or column that you want to delete. In the
toolbar click the Delete selected row button ﬂiE, or the Delete selected
column button .

Text attributes
You can set the global appearance of cell text through the Cell Font
option. You can also modify part of a text in a cell.

To select text
With the text cursor, do one of the following:

Drag over a character, word, or an entire text block to select it.
Double-click a word to select it. Spaces next to the word are not
selected.

e Triple-click anywhere in a line to select a line.

To modify the appearance of part of a text

e Select the text that you want to modify.
e In the toolbar select one or more of the format buttons Bold B, ltalic

I, Underline U, Superscript TS or Subscript T, .

Alignment
You can set the text alignment within a cell for each cell individually.

To set the alignment

1 Select the cell that you want to modify.

2 |nthe toolbar select the Left Align button =/, the Center Align button
=, or the Right Align button =.

Insert text

To insert text in a cell, select that cell and start typing.
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Insert and format variables
You can enter variables in cells and format the output. Variables can be
combined within a cell with text.

To insert a variable

1 Select the cell in which you want to put the variable. Position the text
cursor on the insertion point.

2 Click on the Add DataSource button #" in the toolbar. The Insert Data

source dialog will come up. For more information about this dialog
refer to the Perception manual chapter, “Data source properties”.

Insert Data Source @
Data source Insert Value properties
= Active - V| Value Motation: Unformatted 'J
-9 Group1
.:,.(_ up . Name Format
= Recorder_A i
338 Ch_A1 = Uik ‘
1Ry Ch_A2 2
= %3 Ch_A3
] Highest
e .. Lowest
23 Max
g m Sample:
a3 Min Qutput String:
A Pk2Pk
W5 RMS 2
4 m r

o
=

_‘ l Cancel

Figure 1.14: Insert Data Source dialog

3 Select the source in the list on the left-hand side and select which
parameters you want to use: value, name and units. Optionally define
the notation and format of the value.

4 Click OK. Now a reference to that variable is entered into the cell, for
example {Active.Group1.Recorder_A.Ch_A3.Mean!Value}.

When you close the Table Properties dialog, the table will be updated with
the information provided. When no actual data is available, for example

because a recording has not been made, the placeholder will be shown.
After a recording and after a Refresh Report, the actual data will be filled
in. (See "Refresh Report" on page 31)
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To format a variable

1  When you are not already in the Insert Data Dialog, position the text
cursor somewhere within the variable’s Placeholder and click Add

DataSource.
Insert Value properties
V| Value Notation: Fixed Point 4
Name Format
Units 4
Before separator 2 =
After separator 3 =}
Sample:
Cutput String:

Figure 1.15: Value properties (detail of the Insert Data Source dialog)

2 Notation: within this dialog you can select between multiple output
formats frm the drop down combo box:

Unformatted: take the original information over.

Integer: a number with no decimals

Floating Point: a number with decimals, without fixed ‘layout’.
Fixed Point: a number with decimals, fixed number of places
before and after the decimal separator.

Scientific Notation: a shorthand way of writing very large or very
small numbers. A number expressed in scientific notation is
expressed as a decimal number between 1 and 10 multiplied by
a power of 10.

Engineering Notation: a scientific notation in which the power
of ten is a multiple of three. The power of ten is represented by
prefixes like kilo or milli.

3 For each output format you can select the relevant number of digits.
4 Make your selections and click OK when done.

For each selection you make in the Value properties area an example is
given of the output and the corresponding placeholder, with the value of
Pl as an example.

To add the name or units of a data source

You can insert the name and units of a variable:
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1 When you are not already in the Insert Data Dialog, position the text
cursor somewhere within the variable’s Placeholder and click Add
DataSource.

Insert
V| Value

Name

Units

Figure 1.16: Insert name or units (Detail of the Insert Data Source
dialog)

2 Select Name or Units and click OK. When you clear all selections,
the value will be entered by default. When you clear Value, but select
Name and or Units, the value will not be used.

Table header

You can select to have a table header yes or no. Also you can select a
font for the header different from the global cell font. You make these
settings in the Table Setup section.

Grid lines

The grid lines are the lines between the rows and columns. You can apply
a color and a line weight to these lines. Vertical and horizontal separators
can be switched on and off separately.

Note
The border around the table is set through the container properties as
explained in "Object containers" on page 15.

Global table setup

The global table setup allows you to define the number of rows and
columns of the table. Here you also specify if you want a header and if
so, the font of the header text. The Cell padding is the spacing around
the text, i.e. the distance between the text and the grid lines.

Column sizing

You can set the width of the columns by specifying the relative position of
the column separators. You enter these values directly into the boxes
below the separators.
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Cursor table additional settings
The additional settings for the cursor table include source select, formatting and
cursor(s) select.

A B C

l Source l Formatting J Cursors
Display l Display - ‘ Engineering V| Show horizontal cursors
Page |Page1 v ‘ @ Scientific Show slope cursors

Figure 1.17: Report table object properties - cursor table settings

A
B
Cc

A

Select source: display and page within the display
Formatting: select engineering or scientific

Cursors: show values of specific cursors

Select table source

Here you select the source of the display you want to show. The
Display list gives all available displays within the current workbench,
visible or not. The Page list allows you to select a page within the selected
display.

Formatting
Here you select the number formatting: Engineering or Scientific. See
paragraph “To format a variable” for more details on these formats.

Cursors

As standard the values are displayed of the vertical measurement cursors.
Select which values you also want to be included: the measured values
of the horizontal cursors and / or the measured values of the slope
cursors.

User table additional settings
There is one additional setting for the user table: select the source.

Source

User Table | My User Table b l
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Here you select which user table you want to use. The list gives all available
User Tables within the current workbench.

1.8.4 Insert text
You can insert random text anywhere. Text can include variables. Text can be
a simple label or complete paragraphs describing a test setup.
You insert a text object as described in "Object manipulation" on page 10. You
gain access to the properties of the text object using one of the following
options:
e Directly after placement of the text object the properties dialog comes up.
e With the mouse cursor above the text object, double-click on the object.
e Right-click the object. In the context menu that comes up select
Properties...
A B C D E
I | | I |
'roperties of Text A(lOZ l @
B UurT |S|E Z | |32 =%
This is my text today {System ShortDate}|
————F
e Inset spacing: 200 [mm ] [ Font. o] OK | [ Cancel |[ oply |
G
Figure 1.18: Reporter text object properties
A Set text attributes
B Set horizontal alignment
C Insert and format variables
D Set vertical alignment
E Undo/redo
F Textarea
G Gilobal text font selection
H Inset spacing
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Enter text

To enter text, position the cursor in the text area and start typing.

A, G You can set the global appearance of text through the Font option. You

can also modify part of a text.

To select text

With the text cursor, do one of the following:

Drag over a character, word, or an entire text block to select it.
Double-click a word to select it. Spaces next to the word ar not
selected.

e Triple-click anywhere in a line to select a line.

To modify the appearance of part of a text

1 Select the text that you want to modify.
2 Inthe toolbar select one or more of the format buttons Bold B, Italic

/, Underline U, Superscript TS or Subscript T .

Horizontal alignment
You can set the horizontal text alignment within the text area.

To set the horizontal alignment

® Inthe toolbar select the Left Align button =/, the Center Align button

=, or the Right Align button =.
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Insert and format variables
You can enter variables in the text and format the output.

To insert a variable

1 Position the text cursor on the insertion point.

2 Click on the Add DataSource button #- in the toolbar. The Insert
Data Source dialog will come up.

Insert Data Source @
Data source: Insert Value properties
= Active » | [¥] Value Notation: Urformatted 'J
-9 Groupl
T up . Name Format
--[=5] Recorder_A . .
338 Ch_A1 = Uik ‘
1Ry Ch_A2 2
= %3 Ch_A3
-7 Highest
e .. owest
23 Max
i m Sample:
a3 Min Qutput String:
A Pk2Pk
W5 RMS 2
4 m r

oK | [ Cancel

Figure 1.19: Insert Data Source dialog

3 Inthis dialog select the source, parameters and the formatting as
described earlier in this document.

4 Click OK. Now a reference to that variable with formatting options
is entered into the text.

Vertical alignment
You can set the vertical text alignment within the text area.

To set the vertical alignment

® |nthe toolbar select the Align Top button =, the Align Middle button
=/, or the Align Bottom button =.
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1.8.5

Undo / redo
Certain actions can be undone or redone. If so, the corresponding button
in the toolbar is enabled.

To undo or redo an action

® To undo an action, click the Undo button N,
® To redo an action, click the Redo button ""'.

Text area

The text area is where you place the text. The background and border
of this area are set through the container properties as described in
"Container properties" on page 15.

Inset
The Inset spacing is the spacing around the text, i.e. the distance
between the text and the border of the text object.

Insert graphical objects
The Perception Reporter provides the following graphical objects: line,
rectangle and ellipse.

You insert any of these objects as described in "Object manipulation” on
page 10. You gain access to the properties of each object using one of the
following options:

With the mouse cursor above the object, double-click on the object.

e Right-click the object. In the context menu that comes up select

Properties...
P rties of Line LO01
roperties of Line =) Rectangle [m23m] Ellipse (=
Vector Si Si
6 ize
Length: v B0 ool M [m
ngt IENE | | mm Width: [0 oo = — Width: MEE (mm
Angle: @ 3150 * Height: 1000 |mm = Height: 1010 [mm__ v
0K H Cancel J ‘ OK H Cancel I
[ ok [ cance |[ oty | :

Figure 1.20: Reporter line, rectangle and ellipse object properties

Here you can make the required modifications.
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1.8.6

Insert images

You can insert and scale images, company logos, etc. into your report.

You insert an image object as described in "Object manipulation" on page 10.
You gain access to the properties of the image object using one of the following

options:

e Directly after placement of the image object the properties dialog comes

up.

With the mouse cursor above the image object, double-click on the object.
Right-click the object. In the context menu that comes up select

Properties...

Properties of Image 1001

A ———e Source

B ———e Size
Width: 68.51
Height: 51.38
C ———e Fitting
No fitting

Fit image to frame

Fit frame to image

D ———/] link image

mm n

mm o

@ Bdemal e‘\Desktop‘transmission test setup jpg

5

==

Browse...

BT

Centerimage

@ Fit image proportionally

0K | [ Cancel

J{

Apply

I

Figure 1.21: Reporter image object properties

Image source

Size of image

Embed image

m m o O W

Constrain proportions

Restore image to original size

Fitting of image within frame (container)
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Select image source
Currently most popular bitmap and vector image types are supported.

To select the image

1 In the Image properties dialog click Browse...
In the Open image file to add to report... dialog select the file that
you want to include and click Open.

3 Make the modifications as required in the properties dialog and click
OK when done.

Image size

Once an image is loaded the original size is displayed here. Size is
calculated as resolution (number of pixels) times DPI (dots per inch) by
the OS. When no DPI information is available within the image, the
screen DPI setting (typically 96 or 120) is used.

To change the image size

1 Open the image Properties dialog.
To maintain the current proportions of width to height, select
Constrain Proportions. When the Constrain Proportions icon is

locked i, the aspect ratio of the image is preserved, i.e. modifying
one value will automatically update the other value. When the

Constrain Proportions icon is broken By , the width and the height
can be freely set. The image will be distorted.

3 Enter new values for Width and Height.

4 When you're done setting options, click the OK button.

49



BM Perception Reporter
C, E Image fitting

As mentioned earlier, an image object is placed within a container. You

can define how the container (frame) and image fit. Feel free to

experiment the various possibilities:

e Fit Image to Frame Resizes the image to fit the frame and allows
the content proportions to be changed. The frame will not change,
but the content may appear to be stretched if the content and the
frame have different proportions.

e Fit Frame to Image Resizes a frame to fit its content. The frame’s
proportions are altered to match the content proportions, if
necessary. This is useful for resetting a graphics frame that you
accidentally altered.

e Center Image Centers content within a frame. The proportions of
the frame and its content are preserved.

e Fit Image Proportionally Resizes image to fit a frame while
preserving the content proportions. The frame’s dimensions are not
changed. If the content and the frame have different proportions,
some empty space will result.

Figure 1.22: Image fitting examples
1 No Fitting
2 No Fitting -> Center Image
3 Fit Image Proportionally
4 Fit Image to Frame
5 Fit Frame to Image
6 Fit Image Proportionally -> Center Image
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When playing around with these options it might be necessary once in

Embed image
To embed the image into the virtual workbench, select Include data in
save.

1.8.7 Insert header and footer
Headers and footers have a fixed position. To add a header or footer click on
the header or footer button in the tools area. In the dialog that comes up enter
the text and layout of the header or footer.
A B C D
l l | l
|i Properties of F001 l @
B I UTS 75 (8] & # | &
Left Center Right
’HBM | {Reporting.Page} | {System.LongDate}
nsed Properties of HO01 @
B I UT 75 (8] & # | §
Left Center Right
E _!_. | Report of Experiment |
F ——e Inset spacing: 100 (mm Font... J | oK ‘ [ Cancel ] [ Apply ]
G

Figure 1.23: Reporter Header/Footer object properties

@ Mmoo m >

Set text attributes

Insert page number / number of pages
Insert and format variables

Undo / redo

Text areas

Inset spacing

Global text font selection

The header and footer have three text areas with fixed alignment, one for the
left-hand side of the page, one for the center and one for the right-hand side of
the page. For each text area use techniques as described below.
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Enter text

To enter text, position the cursor in the text area and start typing.
A, G Text attributes

You can set the global appearance of text through the Font option. You
can also modify part of a text.

To select text
With the text cursor, do one of the following:

Drag over a character, word, or an entire text block to select it.
Double-click a word to select it. Spaces next to the word ar not
selected.

e Triple-click anywhere in a line to select a line.

To modify the appearance of part of a text

1 Select the text that you want to modify.
2 In the toolbar select one or more of the format buttons Bold B, ltalic

I, Underline U, Superscript TS or Subscript T .

Insert page number / number of pages
You can insert the current page number and total number of pages.

To insert a page number / number of pages

1 Position the text cursor on the insertion point.

2 Click on the Page Number icon £ or Number of Pages icon (& to
insert a placeholder in the text.
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C Insert and format variables
You can enter variables in the text and format the output.

To insert a variable

1 Position the text cursor on the insertion point.

2 Cjick on the Add DataSource button #" in the toolbar. The the Insert
Data Source dialog will come up.

Insert Data Source @
Data source: Insert Value properties
= Active » | [¥] Value Notation: Urformatted 'J
Name Format
5 Units 4
-2 Lowest
23 Max
i m Sample:
a3 Min Qutput String:
A Pk2Pk
W5 RMS 2
4 m r

oK | [ Cancel

Figure 1.24: Insert Data Source dialog

3 Inthis dialog select the source, parameters and the formatting as
described earlier in this document.

4 Click OK. Now a reference to that variable with formatting options is
entered into the header or footer text.

D Undo / redo
Certain actions can be undone or redone. If so, the corresponding button

in the toolbar is enabled.

To undo or redo an action

®  To undo an action, click the Undo button \,
® To redo an action, click the Redo button "'.

E Text areas
The text area is where you place the text.
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1.8.8

1.8.9

F Inset
The Inset spacing is the spacing around the text, i.e. the distance
between the text and the border of the text object.

Scroll/pan zoomed area
If the entire page is not visible in the document area, you can navigate to bring
another area of the page into view.

Use the Pan tool ‘& from the Tools palette and drag to pan over the page.

Also the zoom area indicator is shown in the Navigate area. You can click and
drag this area to a new location. When you release the mouse, the report page
will be updated.

Zoom

Use the zoom tool from the Tools palette to freely set a zoom area in the page
area, or use the zoom select control on the lower toolbar to use a predefined
zoom factor.

10%
25%
50%
75%
100%
150%
200%
300%
400%

Page width —
Full page - ':) ,/;) I
Cc

B

:)
|
A

Figure 1.25: Reporter zoom tools
A Decrease zoom level

B Select zoom level

C Increase zoom level
D

Zoom tool from Tools palette: free style zooming. Click and drag to select
the zoom area.
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Decrease zoom level

Click on the Decrease button to zoom out. Each click reduces the view
to the previous set percentage. When the page has reached its maximum
reduction level, the button is dimmed.

Select zoom level
Click the Zoom Level pop-up menu, and choose a zoom level

Increase zoom level

Click on the Increase button to zoom in. Each click magnifies the view to
the next set percentage. When the page has reached its maximum mag-
nification level, the button is dimmed.

Using the zoom tool
To magnify by dragging

1 Select the Zoom tool
2 Drag over the part of the page you want to magnify.
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1.9

1.9.1

Report to Word

Introduction

In addition to the Report Sheet, an advanced "Report to Word " feature is also
included in the Reporter Option. This feature can be found in the Automation
menu. The Report to Word feature makes it possible to place Perception objects
at predefined locations in a Microsoft Word template. By doing this, a report can
be generated in Word tests, each with exactly the same layout. Combine your
own text and layout in Word with dynamic data from Perception. No cut-copy-
paste procedures are required and you can fully customize and automate your
reports, if necessary.

This chapter describes how you can set up Word reporting in Perception.

Word reports can be created in the Perception Automation menu. These menu
items, i.e. actions, are used for various Automation processes. (see Figure
1.26 for further details).

Automation

Q Disable Manual logging

Configure Logfile...

Add to Logfile Ctrl+L
@ Clear Logfile

@ Open Logfile in Excel

A ———=e Process Display Ctrl+M
B—— Setup Process Display... Ctrl+Shift+ Alt+M
C ———eRecordings Batch Processing...  Ctrl+Shift+Alt+B

D —=e Automated Recording Processing...

Merge Files...

E =0 Report to Word...
F Quick Report to Word...

Figure 1.26: Automation menu

A Process Display Select this option or press the Ctrl+M key combination
to create a Word report linked to a specific display manually.

B Setup Process Display... Select this option or press the
Ctrl+Shift+Alt+M key combination to create a Word report linked to a
specific display manually.

C Recordings Batch Processing... Select this option or press the
Ctri+Shift+Alt+B key combination to create Word reports after you have
done a number of recordings.

D Automated Recording Processing... Select this option to create a Word
report after each recording automatically.
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E Report to Word... Select this option to create a Word report manually.

F Quick Report to Word... Select this option to create a Word report
manually by using a simple report layout.

1.9.2 Report to Word by using Setup Process Display

Note

The following chapter shows an example of a Report to Word. The Process
Display option will be used to illustrate this.

1 Select Automation » Setup Process Display from the menu bar.

Make sure that you have an active display in the selected sheet.
The following setup dialog will be shown:
Setup Process Display @
Interval selection Automation actions
@ Complete recording Select action and add to action list:
Report to Word <[ Ak |
Action list:
Triggered segments O
(5%
10
Data source for Export and Post
@ Cument trace Current page
Curent pane All traces in display
[ Process J ‘ Close

Figure 1.27: Setup Process Display dialog
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Automation actions
Select action and add to action list:

[Report to Word

Add to logfile
Export to
Post to

Print Perception report
Quick report to Word

T 7 —=

Run extemal program

Save a copy as

Save Perception report
1

=—A

Figure 1.28: Automation actions (Detail)
A Report to Word option

Automation actions
Select action and add to action list:

[Repcrt to Word

S

Action list:

R O

(&

Configure... o

2 Select Report to Word action from the Automation actions list.

3 First click the Add button to add this option to the action list and then click
the Configure button in the Automatic Actions area.

A Add a Report
B Configure a Report
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4 The Report to Word configuration dialog comes up:

Report to Word e ——— E
Select a reference document to use as template. Select the Word bookmarks that you want to use in your
final report. Use Edit item to link @ Perception object to a Word bookmark. Click Report now to create your
document.
Reference document:
C:\Perception Word Demo'\Templates\HBM Demo Template doc Browse...
A 1 1
Link list:
——— Bookmark in Word Perception Object Type Open list... ]o—— F
kg S Save list... ~— G
|¥| Recording_Name
[¥] Result_Display
[¥] Result_Table
B —
Edtitem.. e——— H
Clear item — |
Report document:
D:"-\'MyDocs"n.Damme"-.Documents"-.Report.doc Bﬂ;‘ﬁsem ] [ Build.... ]o—— J
C [¥] View generated report in Word after creation
D —
Close — E

Figure 1.29: Report to Word configuration dialog

The Reference document used

A link list containing bookmarks linked to Perception objects

The Report document that will be generated

A check box to view the report generated in Word after its creation
Close to close the dialog and save all settings

Link list to open a link list

Save list to save a link list

I G M m U O W

Edit item to set up the selected item

Clear item to clear the selected item

J Build to open the Build Storage Path and File Name dialog

A Reference document Name of the reference document which will be
used as the template for new Word documents to be generated. Click
Browse... to navigate to the desired reference document. The
Browse... command will open the common File Open dialog.

B Link list This list shows all the links between the bookmarks from the
Word document and the Perception objects.
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C Report document The name and folder where the generated Word
documents will be saved.

D A check box to view the report generated in Word after its creation.
E Close to close the dialog and save all settings.

F Open an existing Link list containing links between the bookmarks
and the Perception objects. This can be used to accelerate the setup
procedure of a new configuration.

G Save list Save the current Link list. This saved list can be re-used to
set up a new configuration later.

H Edit item Edit an item from the Link list. This dialog allows you to
define the relationship between the Bookmark and the Perception
object.

I  Clear item to clear the link to the Perception object.

J  Build to open the Build Storage Path and File Name dialog. This
dialog allows you to build a file name and full storage path based on
Perception system variables.

Define the Reference document:

Report document is used to define the output (result) file. You can either
type in the name of the document directly, or click the Browse button to
navigate to the reference document (B). This reference document will be
used as a template for your Word reports. Placeholders mark the location
where Perception objects have to be inserted in the template. These
placeholders are called Bookmarks in Word.

The reference document can be a Word document (*.doc, *.docx) or a
Word template (*.dot, *.dotx)

For information how to insert bookmarks, refer to chapter "How to add
Bookmarks to a Word template file" on page 75.
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Beference document:

A ——e"_:\Perception Word Demao*\Templates\HEM Demo Template doc: Browse... ~— B

wink list:

Bookmark in Word

Perception Object Type

c Recording_Name
Result_Display
Result_Table

|
D E F

Figure 1.30: Report to Word dialog (Detail)
Name of the reference document
Browse to the reference document
Link list

Bookmark in Word

Perception Object
Type

Mmoo w >

The path and the name of the selected Reference document is shown :
C:\Perception Word Demo\Templates\HBM Demo Template.docx

Note This Word reference file is just an example and is not part of the Perception
installation.

After inserting the reference document, Perception will search for all the
bookmarks in this document and display them in the Link list (C). In this
example, you can see that Perception found four bookmarks (D):

Recording_Date
Recording_Name
Result_Display
Result_Table

The link list has the following columns:
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Bookmark in Word A list of bookmarks found in the reference

document. Each bookmark has a checkmark. If selected, the

bookmark will be used and replaced by the Perception object. This

allows you to:

e Create a (default) link list that has more information than
required for a specific output document.

e Open a reference document that also uses bookmarks for
other purposes.

Perception Object The name of the Perception object linked to

the bookmark.

Type The type of the selected object. This field cannot be edited.

Link the bookmarks to Perception objects. Perception has four different
kinds of objects which can be linked to a bookmark:

Data sources
Displays
Tables
Images

Select the bookmark Recording_Date in the link list and Click the Edit
item button to open the Edit item dialog (see Figure 1.29).

Figure 1.31 shows how to define the link between the bookmark and a
Perception object. The Edit item dialog has four tabs which are related to
the four different kinds of Perception objects available for linking the
bookmarks:

Data Sources
Displays
Tables
Images
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A B IIE
Edit Item l l @
Bookmark: Selected object:
Dat : Insert Value properties
= [ value Unformatted
[T Name Format
=-f5] Recordinglnformation [ nits i
L8 LocalTime 2
L. Title
-8
L.E® UTCTime
Sample:
Qutput String:
[, 0K | LTCanceI
D E
Figure 1.31: Edit item dialog - Data Source tab
A Bookmark field
B Selected object field
C Tabs that represent Perception objects
D OK button
E Cancel button
In the top area of the dialog, the (previously) selected Bookmark and the
currently Selected object are displayed. These fields cannot be edited. If
you click OK, this is the link that will be defined. Click Cancel to discard all
changes or works in progress, revert to the previous state, and close the
window.
If the RecordingIinformation data source is not present, open an existing
recording an active source or make a new recording.
If a check box in the Insert area is selected, you can insert a variable on
the right-hand side of the dialog. For more information, refer to Figure 1.24
"Insert Data Source dialog" on page 53.
Each tab, and therefore each object type, has its own set of properties. These
properties are derived from the currently available property settings as used
when inserting objects into the Perception reporter.
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After you have closed the Edit Item dialog, the newly established link

between the Bookmark in Word and Perception Object is shown (see
Figure 1.32).

A
Link list: |
Bookmark in Word Perception Object l Type
Recording_Date Active Recordinglnformation U...  Text

Recording_Name

Result_Display
Result_Table

Figure 1.32: Link list with Perception Object (Type Text - Part 1)
A Perception Object

Repeat the procedure described above (Step 6) for the
Recording_Name. Link it to the data source
Active.Recordinginformation.Title (see Figure 1.33).

Link list:

Bookmark in Word Perception Object
Recording_Date
Recording_Name
Result_Display
Result_Table

Type
Active Recordinglnformation.U...  Text
Active Recordinglnformation. Title  Text

A

Figure 1.33: Link list with Perception Object (Type Text - Part 2)
A Perception Object
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8 The next bookmark, Result_Display, will be linked to the active display.
Select the Result_Display bookmark in the Link list and then click the
Edit item button. Select the Displays tab in the Edit Item dialog (see

Figure 1.34).
Edit Item
Bookmark: Selected object:
A ‘ Tables I Images ‘
Displays: Source Show
T .. 9] Veticalcursrs
[ Horizontal cursors
@ Total

[] Slope cursors
[] Grid lines
Display markers
[¥] Header area

) Zoom

") Altemate zoom

Color Size
) Black on white X-annotation height: 500 |mm ~
@ Cglor on white Y-annotation width: 20.00 @

D Asis (WYSIWYG) Trace width: 0.10 @

Annotation font... I

[ ok ][ Ccancel

Figure 1.34: Edit Item - Displays tab
A Displays tab

The Displays list shows all the displays which are available in Perception.
In this example, the available display is called Display.

You can configure the way the display is shown in your Word document
on the right-hand size of the area.

Source Page number, Zoom modus

Color Balxk on white, Color, WYSIWYG

Show Cursors, Grid lines, Display markers, Header area

Size X-annotation, Y-annotation, Trace width
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Confirm your settings with OK and the Link list will be updated (see Figure
1.35).

Link list:

Bookmark in Word Perception Object
Recording_Date
Recording_Name

Type
Active Recordinglnformation.U... Text

Active RecordingInformation. Title  Text

Result_Display
Result_Table

A

Figure 1.35: Link list with Perception Object (Type Display)
A Perception Object

The last bookmark, Result_Table, will be linked to a Perception user table.
Select the bookmark in the Link list and then click the Edit item button.
Select the Tables tab in the Edit Iltem dialog (see Figure 1.36).

Edit Item ==
Bookmark: Selected object:
| Data Sources | Displays |; Tables ;| Images|
Tables:

B User Table 2

[ ok ][ cancel

Figure 1.36: Edit Item - User tables
A Tables tab

B List of User Tables
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Figure 1.36 shows all the user tables which are available in Perception
(B). There are no configuration possibilities in the Edit Item dialog for
Tables. Select the desired user table and click OK. The Link list will be
updated (see Figure 1.37).

Link list:

Bookmark in Word Perception Object Type

[¥] Recording_Date Active RecordingInformation. ... Text

Recording_Name Active . RecordingInformation. Title  Text

[¥] Result_Display Display Display

Result_Table
Figure 1.37: Link list with Perception Object (Type User Table)
A Perception Object
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1.9.3  Build Storage Path and File Name
All bookmarks have now been linked to a Perception object.
1 Define the name and location of the Word file(s) to be generated:
Report to Word @
Select a reference document to use as template. Select the Word bookmarks that you want to use in your
final report. Use Edit item to link @ Perception object to a Word bookmark. Click Report now to create your
document.
Reference document:
C:\Perception Word Demo\Templates'"HBM Demo Template doc:
Link list:
Bookmark in Word Perception Object Type Open list...
[¥] Recording_Date Active RecordingInformation.lU...  Text
Recording_Name Active RecordingInformation. Title  Text -
[¥] Result_Display Display Display
Result_Table User Table Table
Clear item
Report document:
A ——e]):\MyDocs"\Damme"Documents‘\Report.doc Browse... ] [ Build... ].__ B
View generated report in Word after creation
Figure 1.38: Report to Word configuration dialog
A Report document text box
B Build
Type a name into the Report document text box.
The name in the Report document field can be edited to make it possible
to create a new, unique name each time a Word document is generated.
To do this, click the Build button.
68

12692-2.0 en



HBM Perception Reporter

2 The following dialog comes up:

Build Storage Path and File Name @

Here you select the options that allow you to build a file name and full storage path based on system
variables.

A ————e Folder
Foldername:  D:\MyDocs‘\Damme"\Documents Browse...
[7] Add recording date to folder name
[ Add recording time to folder name
B ——eFie
File name: Report Extension: | doc - o— D
[7] Add recording name to file name:
[7] Add recording date to file name
[7] Add recording time to file name
[ Autonumber to the file name, start at: 1 Digits:
[ Add trigger number to file name
[] Overwrite existing file
Full path example:
C ———):\MyDocs"Damme"\Documents‘\Report.doc

oK | [ cancel

Figure 1.39: Build Storage Path and File Name dialog
A Folder settings

B File settings

C Full path example

D

File name extension

A Folder Define the location or storage path of the Word file(s) to be
generated. The folder name can be linked to the recording date and/
or recording time.

The folder name can also contain the recording date and/or recording
time, if you select the respective check boxes.
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B File Define the name of the Word file(s) to be generated.

The options below allow you to define a more complex filename, which

can include:

e Recording name The recording name, as set in the Acquisition
Control palette.
Recording date
Recording time
Autonumber A number that automatically increases by 1 for every
new file, starting at the number specified and consisting of the
specified total number of digits.

e Trigger The number of the triggered segment that contains the
data to be saved.

e Overwrite When this option is selected, only one file is created
each time the action is initiated.

Placeholders

In addition to the options described above, you can also edit the
filename. The fields described above (B) insert placeholders to the
filename box. The placeholder is inserted on the cursor position within
the text box when you select the option. You can cut and paste text in
the filename box. This sets the placeholders and the file name text, if
it was changed, in the desired order. A placeholder is a text identifier
between percent (“%”) symbols, which is automatically replaced by
another text when its value is calculated (for example, %date% will be
replaced by the current date). These placeholders are documented in
the Export Formats User’s Guide.

Typical placeholders are:
o %recname%
%date%

%time%
%autonumber%
Ytrigger%

C Full path example

D Extension The extension of the Word document to be generated.
* .docx is recommended.

3 For this example, you can select the same settings as shown in Figure
1.39. The complete setup is done and Perception is ready to generate the
new Word document(s). This can be done in various ways.

Note Creating a test to check if your configuration is OK is recommended.
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An easy way to do this is to click the Process button in the Setup Process
Display dialog (see Figure 1.40).

Setup Process Display @
Interval selection Automation actions
@ Complete recording Select action and add to action list:
[ Add to logile < Ak ]
Action list:
SRR O
) Triggered segments
10
Data source for Export and Post
@ Curment trace ) Cument page
) Cument pane ) Alltraces in display | Configure... |
Process Close
b

Figure 1.40: Setup Process Display dialog

A Process

If the test document is OK, you are ready to use the Report to Word action
during the post evaluation of the recorded data. In our example, you can
generate the Word report by selecting Automation » Process Display from
the menu bar. If the data is active in the display, you can also press the
Ctrl+M key combination to generate the Word report.

For this example, a Report to Word action was added to the Process
Display automation feature, but you can add the same action to:

e Recording Batch Processing
e Automated Recording Processing

Use the Recording Batch Processing to create a Word report for a (large)
number of recordings you have selected. All reports will have the same layout,
but the actual data, calculations, etc. are specific to each recording. Once you
have created those word reports, you can use the Word Organizer to create
an overall combined end report.

Use the Automated Recording Processing to create a Word report after a
recording is finished automatically.
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1.9.4 Report to Word using the Report now button
Build the link list
Whereas the Quick Report always creates a new empty document and places
the objects underneath each other, the Report to Word feature makes it
possible to place Perception objects at predefined locations in a template. By
doing this, a report can be generated in tests, each with exactly the same layout.
In addition to placing objects at specified locations, you can configure some
objects completely. Report to Word can be started manually or automatically.
All settings are defined in the following dialog:
Report to Word G J
Select a reference document to use as template. Select the Word bookmarks that you want to use in your
final report. Use Edit item to link a Perception object to a Word bookmark. Click Report now to create your
document.
Reference document:
C:\Users\Public\Documents\Report Template.dotx Browse...
1 ! A
Link list:
Bookmark in Word Perception Object Type = Open list... -— c
B [V] Operator_Name Active.Information.UserName ~ Text [E C
Recording_Date System.ShortDate Text |
[¥] Recording_Name Active.Information.Comment  Text B
Result_Display Display.Display.Active Cursor  Datasource i
[¥] Result_Name Formula.sum Formula
[ Emen. +1—D
[7] Result_Recording_Number
Result Table 1 v Clearem  e——— E
Report document:
C:\Users\Public\Documents\source \Report.doc T [ Browse... _J [ Build... ’J—— G
H D —— View generated report in Word after creation F
[ Report now ] [ Close ]
| J
A The Reference document used
B A Link list containing bookmarks linked to Perception objects
C Buttons to Open or Save a link list
D Edit item to set up the selected item
E Clear item to clear the selected item
F The Report document that will be generated
G Build to open the Build Storage Path and File Name dialog
72

12692-2.0 en



HBM

Perception Reporter

12692-2.0 en

Note

H A check box to view the report generated in Word after its creation
I Report now to start reporting

The Report now button is not available when configuring this as an automatic
action.

J Close to close the dialog and save all settings

A Reference document The Reference document is located at the top of
the dialog. You can either type in the name of the document directly or use
Browse... to locate the file. The Browse... command will open the
common File Open dialog.

B Linklist When the reference documentis open, the Link list appears. The
link list has the following columns:

e Bookmark in Word: A list of bookmarks found in the reference
document. Each bookmark has a checkmark. If selected, the
bookmark will be used and replaced by the Perception object. This
allows you to:

e Create a (default) link list that has more information than required
for a specific output document.

e Open a reference document that also uses bookmarks for other
purposes.

e Perception Object: The name of the Perception object linked to the
bookmark.

e Type: The type of the selected object. This field cannot be edited.

C Open or Save Click Save list... to save the link list for future use. This
command will open the common File Save dialog.
To load an existing link list, click Open list... This command will open the
common File Open dialog.

D Edititem... to add an object or modify an existing link, click Edit item...
This command will open the Edit Link dialog, where you can add an object,
select another object and enter formatting information.

E Click Clear item to clear the Perception object fields. This will not delete
the bookmark. Multi-selection is possible for this command.
To see the results of the report in Word, select View generated report in
Word after creation .
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F The Report document is used to define the output (result) file. You can
either type in the name of the document directly, click Browse... to locate
the file or build an output path via the Build Storage Path and File
Name dialog. The Browse... command will open the common File Open
dialog.
G Build to open the Build Storage Path and File Name dialog.
H Selectthe check box to view the report generated in Word after its creation.
I Click Report now to create the report.
J Click Close to close the dialog. All settings will be saved for later use.
The settings are saved with the Virtual Workbench and therefore with the
recordings created as well.
Note For information how to insert bookmarks refer to chapter "How to add
Bookmarks to a Word template file" on page 75. An example reference file can
be found in the shared documents folder after installing Perception . This
example file explains how to set up a reference file.
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A1

A1A1

How to add Bookmarks to a Word template file

A bookmark identifies a location or a selection of text that you name and identify
for future reference. For example, you might use a bookmark to identify the date
of arecording. Each time Perception generates a Word report with this template
file, the specified bookmark will be replaced by the date of the current recording.

You can assign a bookmark to a word item. The bookmarked item appears then
in brackets [...]. If you assign a bookmark to a location, the bookmark appears
as an I-beam. The brackets and the I-beam do not appear in printed documents.

Enabling the Show bookmarks option in Word is recommended if you want to
add bookmarks to your template file.

1 Microsoft® Office 2007:
Click the Microsoft Office Button ‘“Y and then click Word Options.
Microsoft® Office 2010:
Select the File tab and then click Options.

2 Click Advanced, and then select the Show bookmarks check box under

Show document content.
3 Click OK.

This appendix describes four different kinds of bookmarks. These bookmarks
are:

e Insertion Point: Marks only the location of the bookmark; size is not
defined.
Text: Plain text in a placeholder.
Image: An image can be contained in placeholder.
Table: The bookmark contains a table.

Insertion Point Bookmark
To add an insertion point bookmark:

1 Position the cursor where you want to insert the bookmark in the Word
document.
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2 Onthe Insert tab, in the Links group, click Bookmark

Wid9- ol
Home Insert Page Layout References Mailings Review View
SN D LBl QR

Shapes SmartArt Chart Screenshot Hyperlink Bookmark Cross-reference

Table Picture Clip

Cover Blank Page
Art

Page~ Page Break
Pages Tables

Tllustrations Links

Figure A.1: Insert tab with Bookmark icon selected (Detail)

A Bookmark

In the Bookmark, dialog you can enter the name of the bookmark, and click
Add.

3

Bookmark @
Bookmark name:
A = bookmark_1 Add e—— B
-
bookmark_2

Sortby: @ Name
~) Location

[ Hidden bookmarks

Cancel

Figure A.2: Bookmark dialog
A Bookmark name

B Add a bookmark

When done, the bookmark looks like this:

I If you assign a bookmark to a location

[selected_text] If you assign a bookmark to a word item
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A.1.2

Note

A1.3

Note

A1.4

Text Bookmark
To insert a text bookmark:

1 Position the cursor where you want to insert the bookmark in the Word
document.

2 Select the desired text and then click Bookmark.

3 Enter a name for this bookmark (see Figure A.2).

When done, the bookmark looks like this: [selected_text]

The selected text will be replaced by the object linked fo it.

Image Bookmark
The Image bookmark is best used when you want to post a Perception
Display or Image object into a Word document.

To insert an image bookmark:

1 Position the cursor where you want to insert the bookmark in the Word
document.

2 Insert an arbitrary picture and scale it to the size you want the posted
Perception object to be.

3 Select this image, click Bookmark and enter a name for this bookmark.
(see Figure A.2 "Bookmark dialog" on page 76)

When done, the bookmark looks like IMAGE PLACEHOLDER
this:

If a Perception Display or Image is posted to this type of bookmark, it will be
the size of the image in the bookmark. The original image will be replaced.

Table Bookmark
The Table bookmark is used when you want to post a Perception User Table
object in a Word document.
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Note

To insert a table bookmark:

1 Position the cursor where you want to insert the bookmark in the Word
document.

2 Insert a table. The number of rows and columns are defined by the
Perception User Table, which will be posted to this bookmark. Therefore,
the number of these is unimportant.

3 Select the table, click Bookmark and enter a name for this bookmark. (See
Figure A.2)

When done, the bookmark looks like this:

If a Perception User table is posted to this type of bookmark it will have the
same width as the placeholder. The inside columns are scaled proportionally.
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Index
B EXamples ... 16
Object manipulation .........ccccccoviiieieiiieee e, 10
Bookmark in Word Margins, grid and labels ...........c..ccocoevvrernennee. 13
Image Bookmark ..., 77 Select MUItiple ODJECES .....vevevreeeeeeeeereeeeereean. 11
Insertion Point Bookmark ...........cccccceeeieieennnnn. 75 Objects
Table BOOKMarK ..o ” AlIGNEMENT ....vevieiececeeeece e 20
Text Bookmark ..., 7 ARFIOULES ... 17
Build Storage Path and File Name ..................... 68 AHTIOULES/LOCK ... 18
Attributes/Position ..........cccccoiiiiiiiii 17
c Attributes/Repeat ... 18
Attributes/Size ........ccccciii, 17
ContaiNer ... 15 Bounding boX ......oooiviiiii e, 19
INSEIt ~ oo 10
MOVE ~ e 12
D SCAIE = eovveeeeeereeeeesreseeeeeeeeeeee e 12
DESIGN tOO0IS ... 33 Seleclt T 1
Cursor table additional settings ................... 43 Stacking ~ eeeeiiii 13
Insert @ display ........cccoeeeiiiiiieiiiie 34
Insertatable ..o 36 P
Insert graphical objects ..........cccocoiiiiiiiinnnn. 47
Insert header and footer .........cccoccevveiiiinennn. 51 Page
INSEITEEXE ©eeeeee et 44 Delete ..o 24,29
Pointer / selector ........cocooviieeiiiiiiieeeieeeeen, 33 [ 11T o AR 23, 29
Scroll/pan zoomed area ...........ccccoeeeeeeeeeeeennnn. 54 Orientation .......cceeeveieeee e 26
b o o] 1 ISR 54 SeleCt ..oiiiii i 23
SIZE i 26
Page navigation ..........ccccceiiiiiiiiiiii e 21
G Moving the zoom area ...........ccccoovveeeeeiiinnenn, 23
1T I 13, 28 Page Select ... 23
Z00mM SEIECE ....veiiiiiiiiiee e 21
Printer margins ..........ccccceieiiiieieie e 13
I
INtFOAUCHION ... 7 R
Report Menu .......c.cooviiiiiiiiie e 25
L Delete Pages .......cccccoveeeeeeeeeeeeee e 29
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